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Downloads de imagens pelo GLCF  
Imagem do satélite Landsat previamente registrada, disponível no catálogo Global 

Land Cover Facility – GLCF (http://glcf.umiacs.umd.edu/). 

 

1 - Clique em “ESDI” 

 

 

2 - Clique em “Map Search” 

 

 

 

 

 

http://glcf.umiacs.umd.edu/


 

4 – Selecione a imagem 

pela órbita (path) e o ponto 

(row) 

5 - O exemplo mostra a 

escolha pela imagem de 

órbita-ponto 221-71. 

 

6 - Clique em “Preview and 

Download”. 

 

 

 

7 – Escolha a imagem do tipo “Ortho, GLS2005” e clique em “Download” 

 

 

 

 

 

 

 

 



 

8 – Escolha as bandas da imagem com final “BXX.TIF.gz”, como por exemplo 

“B10.TIF.gz” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Downloads de imagens pelo INPE 

 Imagem do satélite Landsat a ser registrada, disponível no catálogo do Instituto 

Nacional de Pesquisas Espaciais – INPE (http://www.dgi.inpe.br/CDSR/). É necessário 

fazer o cadastro no site. 

 

1 - Escolha o satélite “Landsat-5”. 

 

    2 - Escolha a data de interesse. 

 

3 - Filtro para cobertura de nuvens. 

 

 

 

 

4-Preencha a órbita-ponto. O 

exemplo mostra a escolha pela 

imagem de órbita-ponto 221-71. 

 

 

 

 

 

 

 

 

 

http://glcf.umiacs.umd.edu/


 

5 – Escolha a imagem desejada e clique no ícone com o desenho de um carrinho: 

 

 

6 - Para fazer o download das imagens selecionadas clique no link “Carrinho”: 

 

7 – Clique em “Prosseguir”: 

 

 

 

8 - Clique em “Fechar Pedido” 

 



 

 

 Downloads de imagens pelo portal GloVis 

Baixar imagens pelo site do GloVis: http://glovis.usgs.gov/ 

 

 

 

1. Clique em “Collection” no  

lado esquerdo da tela. 

 

 

 

 

 

http://glovis.usgs.gov/


 

 

 

Para fazer download de uma imagem landsat TM-5, por exemplo: 

 

 

2. Selecione a opção “Landsat 

Archive”.  

 

 

 

 

 

 

 

 

 

 

 

3. Marque a opção 

 “Landsat 4-5 TM” 

 

 

 

 



 

 

4. Na opção “WRS-2 

Path/Row” marcar a órbita-

ponto desejada. 

 

 

5. Caso opte por fazer a 

seleção da imagem por 

coordenadas, marque a 

Latitude e Longitude em 

“Lat/Long” 

 

6. Em “Max Cloud” define-se a 

porcentagem de cobertura de 

nuvens da imagem. 

7. Abaixo do quadro “Scene 

Information” onde se 

encontra as informações da 

imagem selecionada há uma 

opção para filtragem por data. 

 

8. Após fornecidos os dados 

para filtragem clicar em “Go”. 

 

 



 

9. A imagem selecionada fica delimitada por linhas amarelas, como ilustra a imagem 

abaixo:

 

 

 

 

 

10. Para mudar a imagem 

selecionada clique em “Prev 

Scene” para voltar a cena 

anterior ou “Next Scene” para 

ir para a cena seguinte. 

 

 

11. Clique em “Add” para 

colocar a imagem selecionada 

na lista das imagens que serão 

baixadas. 

 

 



 

12. As imagens 

selecionadas ficarão na 

janela “Landsat 4-5 TM 

Scene List. 

 

 

 

 

13. Para fazer o 

download clique em 

“Sent to Cart”. 

 

14. Insira seu nome de cadastro e senha, se não possuí-los basta cadastrar-se clicando 

em “Register” 

 

 

 

 

 

 



 

15. Clique no ícone referente ao download: 

 

16.  Para baixar as bandas da cena  em formato .tif selecionar a última opção: 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Download de imagens ASTER GDEM 

ASTER –GDEM (Global Digital Elevation Model) 

O Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER) é 

um instrumento criado por meio de um consórcio entre a NASA e o Ministério da 

Economia, Comércio e Indústria do Japão (METI) que foi colocado a bordo da 

plataforma Terra. O objetivo do ASTER era o de gerar imagens com resolução espacial 

semelhante à do Landsat, porém com mais bandas de imageamento no infra-vermelho 

próximo de ondas curtas (ou SWIR, short-wave infrared). Estas bandas foram 

projetadas de modo a permitir estudos mais avançados da composição dos alvos na 

superfície, especialmente no que diz respeito à composição química de solos e rochas. 

Ao mesmo tempo, o subsistema do visível e do infravermelho próximo (ou 

VNIR, do inglês visible and near infrared) possui uma de suas bandas duplicada, gerada 

de duas maneiras diferentes: as bandas 3N e 3B cobrem o mesmo intervalo espectral 

(0.78 – 0.86 µm), mas a primeira é gerada com o instrumento apontado para o nadir 

(ponto da superfície imediatamente abaixo do satélite) enquanto que na segunda, o 

instrumento é apontado para trás, num ângulo de até 24° (Yamaguchi et al., 1999). 

Deste modo, as duas imagens são geradas com uma pequena diferença denominada 

paralaxe que, assim como acontece com a visão humana, permite a obtenção de 

informações de profundidade. Estas informações são utilizadas para gerar modelos 

digitais de elevação. 

 A partir de 29 de junho de 2009, após um longo período de aquisição e 

validação de dados, estes modelos passaram a ser disponibilizados gratuitamente em 

escala global. Os produtos desta distribuição passaram a ser denominados ASTER 

GDEM. 

O ASTER GDEM foi criado a partir do processamento e correlacionamento de 

1,3 milhões de arquivos de cenas ASTER, cobrindo a superfície terrestre entre as 

latitudes de 83°N e 83°S. Ao todo, o mosaico possui 22.895 imagens de 1° por 1°, 

disponibilizadas no formato GeoTIFF (Geographic Tagged Image File Format), com 16 

bits de resolução radiométrica (1 m de altitude para cada número digital). As imagens 

são georreferenciadas no sistema de coordenadas geográficas, datum horizontal 

WGS84 e modelo geopotencial EGM96. Pixels sem dados possuem níveis digitais 

especiais de -9999, enquanto que os corpos d’água marítimos recebem valor de 0 m 

(RODRIGUES et. al. 2010). 

A resolução espacial de 30m deste produto, bem como a cobertura de 

praticamente 99% da superfície terrestre tornam o ASTER GDEM numa ferramenta 

muito útil para o planejamento de cidades, combate a incêndios, conservação de 

recursos naturais e muitas outras aplicações que exigem informações geográficas 

detalhadas. 

  



 

Passo a passo para se obter as imagens ASTER- GDEM 

 

1-) Entre no site http://www.gdem.aster.ersdac.or.jp/index.jsp e faça seu cadastro.  

 

 
 

2-) Preencha os campos e clique em Next: 

 

 

 

http://www.gdem.aster.ersdac.or.jp/index.jsp


 

3-) Agora novamente na página inicial clique em SEARCH: 

 

 
 

4-) Irá aparecer a página para você buscar sua imagem.  

 

 
 



 

Você pode fazer o download das suas imagens de 4 maneiras: diretamente, por 

polígonos, shapefile e inserindo coordenadas. 

 A maneira mais fácil é diretamente ou desenhando polígonos.  

 

a) Select tiles directly 

 

 
 

a-1) Para pesquisar neste campo, basta clicar na aba Select tiles directly, 

colocar o zoom de acordo com sua necessidade e ir até a área de onde se 

deseja a imagem. O mapa se move clicando e arrastando para onde se quer 

chegar.  

 

 

 

 

 

 

 

 

 

 

 

 

 



 

a-2) Depois de localizada a área, clique em #Grid, a tela ficará assim:  

 

 
 

a-3) Então clique em Start e escolha a quadricula que se encontra a imagem 

que deseja (podem ser até 100 quadrículas por download) e clique novamente 

em Next. 

 

 
 



 

a-4) Irá aparecer a lista das imagens que você selecionou então clique em Next.  

 

a-5) Após isso você terá que selecionar qual a finalidade para a qual você 

deseja a imagem e clicar em Agree. 

 

 
 

 

a-6) Agora basta clicar em Download. 

 

 
 



 

a-7) Agora selecione a imagem e clique novamente em Download e direcione 

para a pasta escolhida. 

 

 
 

b-)       Select tiles by polygon 

 

b-1) Selecione a aba Select tiles by polygon, utilize o zoom como já foi citado, 

clique em #Grid e em seguida em Start e desenhe sobre a área de onde você 

deseja obter a imagem. 

 

 

 
 



 

b-2) Depois de desenhar o polígono clique em OK. E em seguida no “Fix the 

polygon” novamente em OK. Após isso aparecerá a área demarcada, clique em 

Next. 

 

 
 

 

 
 



 

b-3) Aparecerá a lista das imagens contidas no seu polígono:  

 

 
 

 

b-4) Clique em Next. A partir daqui ocorrerá o mesmo processo de download, 

onde se pede a finalidade da imagem e o caminho para salvá-la.  

 

c-)       Select tiles by shapefiles 

 

c-1) Selecione a aba select tiles by shapefiles 

 

c-2) Para utilizar esta opção você terá que selecionar um shapefile salvo no seu 

computador, que tenha de preferência poucos ou apenas um polígono e que 

esteja com a mesma projeção utilizada pelas imagens GDEM, que é o WGS-84. 

 

c-3) Após isto é só realizar o download. 

 



 

 
 

 

d-)       Select tiles by coordinate 

 

d-1) Selecione a aba select tiles by coordinate. 

 

d-2) Insira as coordenadas da imagem que deseja e faça o download. 
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Rodrigues, T. L., Debiasi, P., Souza, R. F. Avaliação da Adequação dos Produtos Aster 

GDEM no Auxílio ao Mapeamento Sistemático Brasileiro. III Simpósio Brasileiro de 

Ciências Geodésicas e Tecnologias da Geoinformação.jul.2010.Recife-PE.p 001-005. 

 

<http://www.gdem.aster.ersdac.or.jp/> acessado em 25 de jun. de 2012. 

 

 

 

 

 

 

 

 

 

 

 



 

Processamento de Imagens 

O software Quantum GIS pode ser adquirido por meio de uma busca simples 

na internet: 

  

 

 

O download pode ser feito gratuitamente pela página do projeto: 

 

 



 

Para o Windows, é possível selecionar as opções standalone installer ou OSGeo4W. A primeira 

é mais indicada para usuários iniciantes, por instalar o aplicativo junto com módulos 

necessários para o processamento de imagens. A segunda opção é indicada para usuários mais 

experientes. 

 

 

 

 
 

A instalação pode ser feita utilizando as configurações default do instalador. Ao final da 

instalação, haverá um ícone de atalho na área de trabalho, por meio do qual você poderá 

acessar o Quantum GIS: 

 

 



 

A tela do programa se assemelha bastante à de programas de geoprocessamento já 

consagrados: 

 

 
 

O programa reconhece automaticamente o idioma do seu sistema operacional, traduzindo 

automaticamente o nome das ferramentas do programa. Neste tutorial, utilizaremos a versão 

em inglês do Quantum GIS, pois a versão portuguesa apresenta alguams falhas de tradução. 

Para mudar o idioma, clique no menu  

 

Para iniciar o processamento, é necessário ter os plugins corretamente instalados no 

programa. Isto pode ser feito por meio do módulo gerenciador de plugins (Clicar em Plugins > 

Manage Plugins…): 

 

 



 

Habilite o Plugin Installer e clique em OK: 

 

 
 

 

Clique em Plugins > Fetch Python Plugins… e aguarde o carregamento dos repositórios 

 

 
 

 

 



 

Selecione o Gdal Tools e inicie sua instalação. 

 

 
 

Clique novamente em Plugins > Manage Plugins… e habilite as ferramentas Gdal Tools e 

Georeferencer GDAL. 

 

 

 



 

A seguir, reúna as bandas da imagem num arquivo só, clicando em Raster > Miscellaneous > 

Merge. 

 

 
 

 

Ao abrir o plugin, selecione a opção Stack Layers (empilhar camadas), selecione os arquivos de 

entrada com as bandas e o arquivo de saída; não se esqueça de especificar o tipo de arquivo 

de saída, como por exemplo, GeoTIFF: 

 

 
 

Após rodar o plugin, carregue sua imagem na tela. Clique em Layer > Add Raster Layer, ou 

ainda, clique Ctrl+Shift+R ou ainda, clique no ícone: 

 

 



 

Selecione o arquivo que será aberto.  A partir daí, você pode selecionar as bandas que serão 

mostradas na composição colorida ou visualizar uma banda por vez em escala de cinza, nas 

propriedades da camada de imagem: 

 

 
 

Para abrir o menu de Propriedades, clique duas vezes no nome da imagem, que aparece na 

lista de conteúdos: 

 



 

Você pode visualizar o histograma das bandas na aba Histogram para buscar o melhor ajuste 

na aba Style. Uma boa opção é selecionar desvios-padrão para normalizar a distribuição de 

cores. Ao selecionar os desvios-padrão, indique quantos desvios-padrão serão utilizados. Não 

se esqueça de selecionar a opção de realce do contraste (Contrast Enhancement): a opção No 

Stretch não ajusta o histograma; selecione portanto, a opção de alongar do mínimo para o 

máximo (Stretch to MinMax). 

 

Ao selecionar a visualização das bandas 4, 5 e 3 na composição RGB, com 2 desvios-padrão e 

realce alongado do mínimo para o máximo, temos a imagem da seguinte maneira: 

 

 

 


